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NEW QUESTION 1
In Cisco Unified Communications Manager Native Presence, what two things is a watcher monitoring in real time? (Choose two.)

. registration status of a specific IP phone

. registration status of the hunt group

. registration status of the MGCP gateway

. registration status of Cisco Extension Mobility of the IP phone
. status of a registered directory number

mooOw>

Answer: AE

NEW QUESTION 2
Which two technologies comprise a Cisco Presence deployment? (Choose two.)

A. Cisco Unified Presence Server

B. Cisco Unity Connection

C. Cisco Unified Communications Manager
D. Active Directory

E. Cisco Unified Border Element

F. Cisco Expressway

Answer: AC

NEW QUESTION 3

Drag the steps on the leftto the correct order on the right for configuring the end user Cisco Unified Personal Communicator.
1 Configure end users in Cisco Unified Communications Manager.
2 Create Cisco Unified Client Services Framework device.
3 Assign license in Cisco Unified Communications Manager.
4 Associate DN to end users.
5 Asgociate CSF device to end user,

Answer:
Explanation: Dirag the steps on the left to the correct order on the right for configuring the end user Cisco Unified Personal Communicator.
| 1 1
2 2
|
3 r 3 1
|
4 4
I
5
| I 5

NEW QUESTION 4
Which options are two on-premise components of Cisco Unified Presence? (Choose two.)

A. Cisco Unified Communication Manager
B. Cisco Unified Contact Center Express
C. Cisco WebEx

D. Cisco Quality Management

E. Cisco Unified Contact Center Enterprise
F. Cisco Unity Connection

Answer: AC

NEW QUESTION 5

Which menu option should be selected to add a desk phone as an endpoint in Cisco Unified Communications Manager?
A. Application

B. Device
C. System
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D. User management
E. Media devices

Answer: B

NEW QUESTION 6

Which two items must first be configured before users can be added into Unity Connection via the Bulk Administration Tool? (Choose two.)

A. partitions

B. classes of service
C. search spaces

D. user templates

E. schedules

Answer: BD

NEW QUESTION 7

An engineer is using Cisco Jabber. Instant messages are transported through which protocol?
A. SIP

B. XMPP

C. H.323

D. SCCP

Answer: B

NEW QUESTION 8

Which Cisco Unified Communications Manager configuration causes an IP phone screen to display a "registration rejected” message?

A. Cisco Unified Communications Manager is unable to reach user IP phone.
B. Cisco Unified Communications Manager database replication status is 2.
C. Cisco Unified Communications Manager auto registration is disabled.

D. Cisco Unified Communications Manager is unable to allocate DN.

E. Cisco Unified Communications Manager subscriber is offline.

Answer: D

NEW QUESTION 9

Which command allows the telephony service of a Cisco Unified Communications Manager Express router to be associated to loopback address 192.168.143.44?

A. ltelephony-servicemax-ephones 4max-dn 8ip source-address 192.168.143.44!
B. 'telephony-servicemax-ephones 4max-dn 8ip bind src-addr 192.168.143.44!

C. ltelephony-servicemax-ephones 4max-dn 8source-address ipv4:192.168.143.44!
D. 'telephony-servicemax-ephones 4max-dn 8ip address 192.168.143.44!

Answer: A

NEW QUESTION 10

An engineer is syncing Cisco Unity Connection with LDAP. Which two things should the engineer consider during this process? (Choose two.)

A. PINs and passwords are replicated from the LDAP database to Cisco Unity Connection database.
B. LDAP authentication must be configured and enabled.

C. There is no limit to the amount of LDAP filters that can be created.

D. SSL certificates from LDAP must be uploaded to Cisco Unity Connection.

E. LDAP synchronization must be configured and enabled.

Answer: CE

NEW QUESTION 10
What is the maximum number of digits that an ephone PIN can have to allow after-hour exempt calling privileges?

moow2>
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Answer: D

NEW QUESTION 13

Which three choices are functions or features of Cisco Unity Connection? (Choose three.)
A. video-enabled messaging through converged networks

B. text-to-speech, which allows access to Exchange emails from a telephone
C. voice-enabled message navigation
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D. voice-enabled dialing to external users
E. automated attendant capabilities
F. automated call rerouting to agents through round robin, longest idle, or broadcast

Answer: BCE

NEW QUESTION 14
Which three methods can remotely force a Cisco Unified Communications Manager Express phone to reset? (Choose three.)

A. Issue a shutdown, no shutdown command on a switch port that provides PoE to a Cisco phone.
B. Issue the restart command under the ephone-dn configuration of the phone.

C. Issue the reset command under the ephone configuration of the phone.

D. Issue the reset command under the ephone-dn configuration of the phone.

E. Issue the reset H.H.H (mac-address) command telephony-service configuration.

F. Issue the reset H.H.H (mac-address) command under global configuration.

Answer: ACE

NEW QUESTION 15
Client A in X site uses an IP phone to call client B in Y site. Engineers have selected SCCP as the default VolP signaling protocol. Which network path will the call
signaling take when client A calls client B?

A. IP phone X > CUCM subscriber > IP phone Y using TCP port 1000
B. IP phone X > CUCM subscriber > IP phone Y using TCP port 2000
C. IP phone X > CUCM subscriber > IP phone Y using UDP port 1000
D. IP phone X > IP phone Y using TCP port 2000
E. IP phone X > IP phone Y using TCP port 1000

Answer: B

NEW QUESTION 20
Which three choices are required for the boot process for a Cisco IP phone? (Choose three.)

A. TFTP services
B. DHCP services
C. Voice VLAN

D. Routing protocol
E. TCP/IP

F. PortFast

Answer: ABC

NEW QUESTION 21
All 50 employees in a company have Cisco IP phones. One employee notices high latency (more than 250 ms one way) on the IP network. How might this latency
impact the employees when they try to make an outgoing phone call?

A. The voice quality cuts in and out

B. The call fails with a busy signal

C. The voice quality sounds like it is under water
D. The conversation has delays and interruptions

Answer: D

NEW QUESTION 24
When creating a hunt group/ring group, where can you change the DN for all the devices at once?

A. Hunt pilot

B. Route pilot
C. Group file

D. Hunt list

Answer: A

NEW QUESTION 26

With GETVPN, if a key server is configured to use multicast as the rekey transport mechanism, then under which of these conditions will the key server retransmit
the rekey messages?

A. It never retransmit the rekey messages

B. it only retransmit the rekey message when it does not receive the rekey acknowledgment from at leastone group member

C. it only retransmit the rekey message when it does not receive the rekey acknowledgment from all group member

D. it only retransmit the rekey message when DPD to the group members fails

E. it always retransmit the rekey message

Answer: E

NEW QUESTION 28
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Which IM and Presence chat feature allows for an always-available chat room that remains active, even if all of the participants leave the chat?

A. Personal
B. Group

C. Persistent
D. Ad-hoc

Answer: C

NEW QUESTION 30
An engineer is configuring the Cisco Unified Communications Manager disaster recovery system. Which three statements about the disaster recovery system are
true? (Choose three.)

A. It requires the use of schedules for backups

B. Backup files are encrypted using the cluster security password

C. If the backup device is listed in a backup schedule, it cannot be manually deleted
D. If the backup does not complete within 40 hours, the backup times out

E. Archiving backups to tape drives is supported

F. SSL is used between the master and local agents

Answer: BCE

Explanation: http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/
drs/9 1 1/CUCM_BK_ D9A29FAD_00_disaster-recovery-system-cucm-91/CUCM_BK_D9A29FAD_00_disas

NEW QUESTION 32

The IP phone of user A is registered with Cisco Unified Communications Manager subscriberl while the IP phone of user B is registered with subscriber2. User A
is speaking to user B on an active call. A junior network engineer mistakenly reboots subscriberl.

What effect does this have on the call?

A. User A can hear B, but B cannot hear A.

B. User A cannot hear B, but B can hear A.

C. This action drops the call.

D. This action does not affect the call.

E. The call remains active, but quality may suffer.

Answer: D

NEW QUESTION 35
An administrator is attempting to add a new IP phone to the network. The phone does not register and continues to cycle through the registration process. The
administrator checks and notices that the IP address assigned to the phone is not in the correct network. What is the cause of this issue?

A. The TFTP server is misconfigured.

B. The DHCP server is giving out false IP addresses.

C. The Cisco Unified Communications Manager is down.

D. The switch port that the phone is connected to is configured with the wrong voice VLAN.
E. The PSTN gateway is down.

Answer: D

NEW QUESTION 37
Where do you add user voicemails in Unity?

A. In users

B. In Administration
C. In Serviceability
D. In Voicemail

Answer: A

NEW QUESTION 40
Which Cisco Unified Communications Manager protocol communicates with collaboration endpoints?

A. SCCP
B. RTP
C.SIP
D. CDP

Answer: C
NEW QUESTION 41
A user in Cisco Unified Communications Manager Administration has been added to the Standard CCM Admin Users group, which includes the Standard

CCMADMIN Administration role, but the user cannot add new users. What is the cause of this issue?

A. The add user capability has been disabled for the group
B. The incorrect group and role were assigned.
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C. The add user capability has been disabled for the role.
D. Only the CCMAdmin user can add users.
E. Users can be added only via LDAP

Answer: C

NEW QUESTION 43
A user is assigned more than one directory number. Which option allows one voicemail box to serve both directory numbers?

A. Alternate Extension
B. Notification Devices
C. Alternate Names

D. Message Settings
E. Caller Input

F. Mailbox

Answer: A

NEW QUESTION 44
Which menu should be used to create a username and password in the Cisco Unified CME GUI?

A. configure > pilot number

B. configure > extension

C. configure > phones

D. configure > system parameters

Answer: C

NEW QUESTION 49
Which two benefits does Cisco Unified IM and Presence Service bring to businesses? (Choose two.)

A. enhances productivity by using availability awareness and reduce communications delays

B. provides Enterprise IM capabilities, such as persistent chat, group chat, and IM history

C. provides and streamlines enterprise audio and video communications

D. enhances communications by providing multipoint conference capabilities

E. supports standard-based XMPP clients by supporting native SIP/SIMPLE and H.323 protocols

Answer: AB

NEW QUESTION 50
In an effort to proactively manage IP telephony infrastructure, a network engineer wants to review usage reports that provide top five users, top five calls, and
traffic summary. Which option describes where this information can be retrieved using Cisco Unified Communications Manager?

A. Navigate to Cisco Unified CM Administration > CDR Analysis and Reporting >System Reports > System Overview > Select desired reports.

B. Navigate to Cisco Unified Operating System Administration > Tools > System Reports > SystemOverview > Select desired reports.

C. Navigate to Cisco Unified Serviceability > Tools > CDR Analysis and Reporting > System Reports > System Overview > Select desired reports.
D. Navigate to Cisco Unified Reporting > Tools > System Reports > System Overview > Select desired reports.

Answer: C

NEW QUESTION 52
An engineer is ensuring that each SIP-based element within a network has a component to route call activities to. Which virtual Cisco UCS server component is
effective in reducing the number of call routing combinations while also simplifying SIP network design and troubleshooting?

A. PBX

B. Cisco Unified SIP Proxy
C. VG Gateway

D. SRST

Answer: B

NEW QUESTION 57
What is the limit of Cisco Unified Communications Manager for IP phones located in one standard cluster?

A. 30000
B. 35000
C. 40000
D. 45000

Answer: C

NEW QUESTION 58
An engineer is adding MCU 4500 to Cisco Unified Communications Manager. Which two configuration areas within Cisco Unified Communications Manager allow
the engineer to perform this task? (Choose two.)
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A. TFTP services
B. SIP endpoint
C. media bridge
D. SCCp endpoint

Answer: BC

NEW QUESTION 61
Which four fields are required when manually configuring IP phones in Cisco Unified Communications Manager? (Choose four.)

. MAC Address

. IP Address

. Hunt Group

. VLAN ID

. Device Pool

. Phone Button Template
. Dial Peer

. Device Security Profile

IOMMmMoOO >

Answer: AEFH

NEW QUESTION 65
Which port is the default port for SCCP call signaling on Cisco Unified Communications Manager?

A. 2000
B. 2443
C. 5060
D. 5061

Answer: A

NEW QUESTION 68
Which file extension is used with the Bulk Administration Tool to automatically populate and insert data into
the database when adding users in bulk?

A.CSV
B. RAR
C.NTP
D. TAR

Answer: A

NEW QUESTION 73
Users report volume issues with recordings in Cisco Unity Connection. Which feature can be disabled to prohibit automatic volume adjustments to recordings?

A. AGC

B. Noise Reduction

C. Audio Normalization
D. VAD

Answer: A

NEW QUESTION 76
What is the default number of days that a message stays in the Deleted Items folder in a Cisco Unity Connection mailbox?

A. 30 days
B. 15 days
C. 60 days
D. 90 days

Answer: B

NEW QUESTION 79

Which command is used to troubleshoot calls as they enter and leave a PRI connection?
A. Debug isdn q 931

B. Show voice call summary

C. Debug voip dialpeer

D. Show dial-peer voice summary

Answer: A

NEW QUESTION 84
Which report in the CAR tool provides information about the call volume for a specified period?
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A. traffic summary report

B. Top N duration report

C. precedence call summary report
D. gateway utilization report

Answer: A

NEW QUESTION 86

An SCCP IP phone places a call to a SIP phone that is registered to the same Cisco Unified Communications Manager Express. During the active call, call waiting
indicates a second call is incoming to the handset, but the user decides to ignore it. In this scenario, what is the combined total number of signaling conversations
and media flows that used the SCCP phone as an endpoint?

moow®»
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Answer: B

NEW QUESTION 91
Which menu does a voice engineer use to create a phone user account in the Cisco Unified CME GUI?

A. Configure

B. Voicemall

C. Administration
D. Reports

Answer: A

NEW QUESTION 95
An IP Phone doesn't log in to Extension mobility, what should you ensure is running to fix this?

A. Application Engine
B. Extension services
C. Mobility services
D. CDP

Answer: A

NEW QUESTION 100
Which industry standard method does Cisco Unified Presence incorporate for communication between different IM clients?

A. Jabber XCP
B. Jabber XML
C. Jabber TCP
D. Jabber TLS

Answer: A

NEW QUESTION 102
An end user reports that conference calls are failing. Which fault domain should be investigated first?

A. IP phone

B. Cisco Unified Communications Manager Media Resources
C. voice gateways

D. network routers and switches

Answer: B

NEW QUESTION 104

An IP phone that is using PoE shows "unknown" in Cisco Unified Communications Manager. What should the engineer do to restore the phone to service?
A. restart the phone from Cisco Unified Communications Manager

B. reset the phone from Cisco Unified Communications Manager

C. enter **# locally on the IP phone

D. check the network cable and switch port

Answer: D

NEW QUESTION 106
Refer to the exhibit.
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Which Cisco Unified Communications platform is being utilized?
A. Cisco Unified Communications Manager Express

B. Cisco Unified Presence

C. Cisco Unity Connection

D. Cisco Unified Communications Manager

Answer: A

NEW QUESTION 107

An engineer receives a report that Cisco Unified Communications Manager is not responding. The engineer needs to use RTMT to check errors. Which menu path

should the engineer follow to install RTMT?

A. System Settings > Plugins > RTMT

B. Unified Communications Serviceability > Downloads > RTMT
C. Application > Plugins > RTMT

D. System > Plugins > RTMT

Answer: C

NEW QUESTION 111
What is needed to support SIP Early Media?

A. Media Termination Point
B. Transcoder

C. Annunciator

D. Conference Bridge

E. DSP

F. Route List

Answer: A

NEW QUESTION 116
Which four characteristics are associated with video? (Choose four)

A. greedy

B. TCP retransmits
C. UDP priority

D. delay sensitive
E. drop sensitive
F. benign

G. Bursty

Answer: ACDG
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NEW QUESTION 121
A user reports that several IP phones in a single department are displaying a continuous "registering" message. Which fault domain should be investigated?

A. network router

B. Cisco Unified Communications Manager subscriber node
C. network switch

D. IP phones

E. SIP gateway

Answer: C

NEW QUESTION 124
A network engineer must set up an end-user account for a SIP device to use for authentication. Which end-user information is used for SIP authentication?

A. account ID

B. password

C.PIN

D. digest credentials

Answer: D

NEW QUESTION 125
Customer requirements dictate that local calls from area code 408 display the ANI as a 7-digit number. Which procedure allows the leading digits to be stripped as
soon as they arrive at the H.323 voice gateway?

A. Set up a voice translation rule, apply the translation rule to a translation profile, and apply the translation profile to the dial peer in the inbound direction.
B. Set up a voice translation profile, apply the translation profile to a translation rule, and apply the translation rule to the dial peer in the outbound direction.
C. Set up a voice translation rule, apply the translation rule to a translation profile, and apply the translation profile to the dial peer in the outbound direction.
D. Set up a voice translation profile, apply the translation profile to a translation rule, and apply the translation rule to the dial peer in the inbound direction.

Answer: A

NEW QUESTION 129
A network engineer wants to delete unassigned phone extensions from the Cisco Unified Communications Manager system. Where is this task accomplished?

A. route plan report

B. directory numbers

C. route plan details

D. enterprise parameters

Answer: A

NEW QUESTION 131
A voice engineer is moving an IP phone from one secure Cisco Unified Communications Manager cluster to another. The phones are not registering to the new
cluster. Which task resolves this issue?

A. reset the phones

B. restart the phones

C. delete the CTL file from each phone manually

D. use the Bulk Administration Tool to import the phones

Answer: C

NEW QUESTION 134
An engineer is configuring Cisco Jabber for iOS. The device name must start with which option?

A. CSF
B. TCT
C.i0Ss
D. BOT

Answer: B

NEW QUESTION 136

How to initiate a cisco Telepresence 1310-65 camera calibration?
A. Troubleshoot>Hardware setup>setup>show focus target

B. Troubleshoot>Hardware setup>camera>show camera target
C. Harware setup>start>camera>setup>show focus target

D. Troubleshoot>Hardware setup>camera>setup>calibrate
Answer: B

NEW QUESTION 141
Which Cisco Unity Connection user field is used to map to an LDAP directory?
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A. SMTP Address
B. Last Name

C. Alias

D. Display Name

Answer: C

NEW QUESTION 146
An administrator group is looking to on-board multiple users with Cisco Unified Communications Manager at one time. Which option should be used?

A. Bulk Administration Tool

B. Product Upgrade Tool

C. Command Lookup Tool

D. Cisco Unified Communications Manager User Options Page
E. Cisco Upload Tool

Answer: A

NEW QUESTION 151
Which two protocols does Jabber use to achieve Presence status? (Choose two.)

A. SIP/SIMPLE
B. XMPP
C. SCCP
D. MGCP
E. SOAP

Answer: AB

NEW QUESTION 153
Where can an engineer find how many unused Cisco Unified Workspace Licensing Standard licenses remain?

A. CAR

B. Cisco Unified Reporting

C. Cisco Unified Communications Enterprise License Manager
D. RTMT

Answer: C

NEW QUESTION 156
A systems administrator wants to integrate a new Cisco Unity Connection cluster with an existing directory in the enterprise. What is one valid user import source?

A. Cisco Unified Communications Manager AXL server
B. Cisco Unified Communications Manager CTI server
C. Cisco Unified Communications Manager TFTP server
D. Cisco Unified Communications Manager MOH server

Answer: A

NEW QUESTION 157
A customer has requested that all employees have “Standard CTI Enabled” and “Standard CCM End User” roles. How would these be assigned prior to being
applied to their accounts?

A. Default Device Profile
B. Credential Policy

C. User Profile

D. Access Control Group

Answer: D

NEW QUESTION 161
Which option can an administrator use to add users to Cisco Unity Connection in different time zones?

A. User Templates

B. Call Handler Template
C. Contact Template

D. Directory Handler

E. Interview Handler

Answer: A

NEW QUESTION 166
An engineer is configuring the Cisco Unified Communications Manager disaster recovery system. Which three statements about the disaster recovery system are
true? (Choose three.)
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A. It requires the use of schedules for backups.

B. Backup files are encrypted using the cluster security password.

C. If the backup device is listed in a backup schedule, it cannot be manually deleted.
D. If the backup does not complete within 40 hours, the backup times out.

E. Archiving backups to tape drives is supported.

F. SSL is used between the master and local agents.

Answer: BCF

NEW QUESTION 171
Which option is added number phone configuration is Cisco Unified Communicator Manager to add conference bridge resource to the phone?

A. Media Resource Group

B. Conference Resource list
C. Conference Bridge

D. Media Resource Group List

Answer: D

NEW QUESTION 172
Users report dropped calls. A network engineer is asked to troubleshoot Cisco Unified Communication Manager to view concurrent calls and dropped calls. Where
are such reports generated?

A. Cisco Call Manager Administration

B. Cisco Unified Reporting

C. Cisco Unified Real-Time Monitoring Tool
D. Cisco Unified Serviceability

Answer: C

NEW QUESTION 174
In which three ways does QoS provide better network service VolP quality? (Choose three.)

. minimizes priority queuing

. manages network congestion
. improves loss characteristics
. supports dedicated bandwidth
. decreases traffic priorities

. increases packet size

TmooOm>

Answer: BCD

NEW QUESTION 178
Which server does Cisco recommend that you configure before a CUCM backup?

A. SFTP
B. FTP

C. SNMP
D. TFTP

Answer: A

NEW QUESTION 181
Which three methods can an engineer use to create users in Cisco Unity Connection? (Choose three.)

A. Local

B. Cisco Unified Presence Server

C. Cisco Unified Communications Manager
D. LDAP

E. TMS

F. Outlook

Answer: ACD

NEW QUESTION 185
Which three features of the Cisco Unified Attendant Console can a user use to streamline the company telephony communications? (Choose three.)

A. promotes a phone call into a video call

B. uses presence status to determine availability

C. reverts back to operator a transferred call

D. provides a conference call with up to 10 participants

E. provides call detail records reports to upper management

F. defines operator working hours and automatically redirect calls

Answer: BCF
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NEW QUESTION 187
You are connecting your voice gateway to the PSTN through digital lines. What is the command you should use for clocking synchronization?

A. Clock source line

B. Clock source internal

C. Clock source free-running
D. Clock source external

Answer: A

NEW QUESTION 188
An administrator wants to see how long a specific IP phone extension is in use during a given period of time. What CAR tool feature would the administrator use?

A. System Reports > Traffic > Summary by Phone Number

B. CDR > Search > By Call Precedence Level

C. Device Reports > Route Patterns/Hunt Groups > Route and Line Group Utilization
D. User Reports > Top N > By Duration

Answer: A

Explanation: Only CAR administrators generate the Traffic Summary by Phone Number report. The report provides information about the call volume for a period
and set of phone numbers that you specify.
Link: http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/service/8_6_1/car/carsytra.html

NEW QUESTION 193
An administrator wants to add and configure an ephone-dn via the Cisco Unified Communications Manager Express web GUI. Which feature must be defined
under telephony service configuration?

A. auto-reg-ephone
B. auto-reg-dn

C. max-ephones

D. max-dn

E. dn-webedit

Answer: E

NEW QUESTION 195
An engineer receives a report regarding choppy voice quality on a call. The user does not remember the details of the call time or the numbers that were dialed.
What should the engineer implement to assist in identifying future issues?

A. Cisco Quality Report Tool
B. Cisco Unified SRST

C. Cisco Unified RTMT

D. Cisco AXL

Answer: A

NEW QUESTION 197
Which type of user in Cisco Unified Communications Manager has an interactive login?

A. Administrator

B. End user

C. Application user
D. Phone user

Answer: B

NEW QUESTION 199
Which option is the Cisco recommended mechanism for delivering voice payload?

A. IntServ
B. DiffServ
C. policing
D. shaping

Answer: B

NEW QUESTION 203
Which call processing agent is based on Cisco 10S software and works with ISR platforms?

A. Cisco Unified Presence Server

B. Cisco Unity Connection

C. Cisco Unified Communications Manager Express
D. Cisco Unified Communications Manager

E. Cisco UnifiedContact Center Express
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Answer: C

NEW QUESTION 205

Why is quality of service critical to voice network traffic?
A. Voice traffic is real-time network traffic.

B. Packets can be resent without affecting conversations.
C. Voice traffic is bursty in nature.

D. Voice traffic cannot be compressed.

Answer: A

NEW QUESTION 207

Drag the functionality on the left to the comrect protocel on the right.

time synchronization NTP
option 150 WLAN

virtual broadcast domain TFTP
IP address management DHCP

option 67

MAC address management

Answer:

Explanation: | 5 - e functionality on the leftto the correct protocol on the right

| time synchronization

I virtual broadcast domain

L virtual broadcast domain

! option 150

IP address management

I O R R T T O I T O T N R W

MAC address management

NEW QUESTION 212

Which three items are required to provision core telephony service on the Cisco Unified Communications Manager Express router? (Choose three.)

A. MAC address

B. IP source address
C. dial peer

D. ephone

E. max-dn

F. max-ephone

Answer: BEF

NEW QUESTION 217
Refer to the exhibit.
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Phone Configuration

) Save

Status

@ Status: Ready

— Phone Type
Product Type: Cisco Unified Client Services Framework

Device Protocol: SIP

— Device Information

E Device 15 trusted
Device Name*

Description
Device Pool™* ' Default v |
Common Device Configuration < Hon-e > v
Phone Button Template * -- Not Selected -- v:
Common Phone Profile* | standard Commeon Phone Profile v
Calling Search Space | < None > v
— Phone Type
Product Type: Cisco Unified Personal Communicator
Device Protocol: SIP
— Device Information
P Device 15 not trusted
Device Name* |'
Description [
Device Pool™ ' -- Not Selected -- v
Common Device Configuration |-< Nnne::- - v_
Phone Button Template I N-ut 5,_.]3,':'1_-3& = = .
Common Phone Profile *  Standard Common Phone Profile B o _v
Calling Search Space i{ Mone > v
Media Resource Group List !:"{_N.;;,-.; > _v
User Hold MOH Audio Source I{ None > _v'::
Network Hold MOH Audio Source ' < None > )

The exhibit shows a partial screen shot for a Cisco Unified Personal Communicator device. When should this device be configured?

A. when configuring the Service Advertisement Framework feature for Call Control Discovery
B. when Cisco Unified Personal Communicator is used in desk-phone mode

C. when Cisco Unified Personal Communicator version 7.0 is used in soft-phone mode

D. when Cisco Unified Personal Communicator version 8.0 is used in soft-phone mode

E. when Cisco Unified Personal Communicator version 8.0 is used in desk-phone mode

Answer: C

NEW QUESTION 218

An engineer needs to reset a user PIN in CISCO Unity Connection where LDAP user synchronization is occurring. To which menu option in the user account must

they navigate to accomplish this reset?

A. Password Settings
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B. Unified Messaging Account
C. Change Password
D. LDAP User Account

Answer: A

NEW QUESTION 222

An engineer receives a service ticket because a user cannot log into Cisco Unified CM User Options. Where can the engineer verify that the user account is

active?

A. LDAP System Configuration
B. LDAP Directory

C. End User Configuration

D. LDAP Authentication

E. Route Plan Report

Answer: C

NEW QUESTION 224
Which type of data file is used for bulk import of users into Cisco Unity Connection?

XIs

.doc
.CSV
pdf

Cow>

Answer: C

NEW QUESTION 227

Which path would you use to implement end users in Cisco Unified Communications Manager Express using Cisco Configuration Professional?

A. Configure > Unified Communications > Telephony Settings > User Settings

B. Configure > Unified Communications > Users, Phones and Extensions > Phones

C. Configure > Unified Communications > Users, Phones and Extensions > User Settings

D. Configure > Unified Communications > Users, Phones and Extensions > Extensions

E. Configure > Unified Communications > Users, Phones and Extensions > Phones and Users

Answer: E

NEW QUESTION 232
Which CLI command must be used to configure the network settings on a Cisco TelePresence 4500 MCU?

A. Static<ip address><netmask><default gateway><DNS server address>

B. Network ip<ip address><netmask><default gateway><DNS server address>

C. Xconfig network address<ip address><netmask><default gateway>

D. Xconfig network address<ip address><netmask><default gateway><DNS server address>

Answer: A

NEW QUESTION 236
Which four devices can be used to provide analog ports, traditional phones, and fax machines? (Choose four.)

A. Cisco VG224 Analog Voice Gateway

B. Foreign Exchange Station Voice Interface Card
C. Cisco High Density VoiceFax Network Module
D. Cisco ATA190 Analog Telephone Adapter

E. Cisco VG350 Analog Voice Gateway

F. Cisco Unified Border Element

G. Foreign Exchange Office Voice Interface

Answer: ABDE

NEW QUESTION 240
What is the interface type that you should use to connect a PSTN analog line to the VolP network?

A. FXS

B. FXO
C.Eand M
D. Serial

Answer: B

NEW QUESTION 244

CUC 10.X supports LDAP integration with several widely used LDAP directories systems, including the following:
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A. Microsoft Active Directory 2000, 2003 and 2008 (support for AD 2012 only in CUCM 10.x and later
B. Microsoft Active Directory Application Mode 2003

C. Microsoft Lightweight Directory Services 2008

D. iPlanet Directory Server 5.1

E. Sun ONE Directory Server (5.2, 6.X)

F. Open LDAP (2.3.39, 2.4)

Answer: A

NEW QUESTION 246
A technician is preparing to activate the needed services in Cisco Unified Communications Manager to integrate with an IM and Presence server. Which four
services must be enabled? (Choose four.)

A. Cisco TFTP

B. Cisco AXL Web Service

C. Cisco CTI Manager

D. Cisco Messaging Interface

E. Cisco Intercluster Lookup Service

F. Cisco Extended Functions

G. Cisco Unified Communications Manager
H. Cisco Directory Sync

Answer: ABCG

NEW QUESTION 250
Which three models of configuration does Cisco Unified Communications Manager Express support? (Choose three.)

A. keyswitch

B. PBX

C. hybrid

D. PSTN

E. WAN

F. voice gateway
G. MOH

Answer: ABC

NEW QUESTION 254
Which two actions take place for proper operation when using Advanced Networking on VCS (choose two)?

A. automatic routing must be enabled

B. manual route must be added using x command route add
C. network interface must reside in the same subnet

D. NAT reflection must be enabled on the firewall

E. Network interface must reside in separate subnet

Answer: BE

NEW QUESTION 255

A voice engineer configured a Cisco Unified Presence client for a new employee. The CSF device and user are associated, but the end user cannot make a call
using Cisco Unified Personal Communicator softphone

mode. Which configuration item should be checked next to identify the issue?

A. Client service framework

B. Common device configuration
C. Calling search space

D. Route pattern

Answer: C

NEW QUESTION 259
Which two directory services are supported by Cisco Unified Communications Manager for Lightweight Directory Access Protocol integration? (Choose two.)

A. Windows Active Directory 2008

B. Novell eDirectory

C. iPlanet Directory Server 4.0

D. Sun ONE Directory Server

E. Open Lightweight Directory Access Protocol 2.1

Answer: AD

NEW QUESTION 261

Which four tasks does RTMT allow an administrator to perform? (Choose four.)
A. View syslog messages.

B. Generate alerts when threshold is below or above user-configured.
C. Monitor a set of predefined management objects that monitor the health of the system.
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D. Collect information and traces about errors or alerts that exist in the RTMT.
E. Reboot the system.

F. Perform incremental backups.

G. Export CDR.

Answer: ABCD

NEW QUESTION 265
A user wants their name to show on their phone instead of their directory number. Which configuration item allows an administrator to do this?

A. Line Text Label

B. Alerting Name

C. External Phone Number Mask
D. Caller Name

E. Description

Answer: A

NEW QUESTION 270
What is the admin profile used for supervisor to modify or configure the recorded messages of customer
employees?

A. annunciator admin
B. recordings admin
C. remote admin

Answer: B

NEW QUESTION 274
A company has a 5-digit dial plan. A junior engineer inquires about the directory number external masks. Why are external masks used?

A. to block calling number identification

B. to enable called number identification

C. to convert the calling directory number to the PSTN routable calling directory number
D. to associate a directory number with a SIP endpoint

Answer: C

NEW QUESTION 278
Which two layers are Cisco Unified Communications component layers? (Choose two.)

A. Infrastructure layer
B. Data link layer

C. Network layer

D. Endpoints layer

E. Transport layer

Answer: AD

NEW QUESTION 282

Jabber for iOS is which Device Name?
A. CSF — Jabber for Desktop

B. TCT — Jabber for iPhone

C. TAB — Jabber for iPab

D. BOT — Jabber for Android

Answer: B

NEW QUESTION 287
Drag the IP Phone Registration steps on the left with the steps on the right.
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The phone uses DHCP to learn its IP address, subnet
mask, default gateway and TFTP server address

The phone loads its locally stored firmware image

The phone contacts the TFTP server and requests its
config file. Each phone has a customized config file named

SEP. cnf. xmi created by CUCM and uploaded to TFTP
when the administrator creates or modifies the phone

The phone obtains the Power (PoE or AC adapter)

The phone learns the Voice VLAN ID via CDP from
the switch

Select and Place:

Answer:

Explanation:

Passing Certification Exams Made Easy

Step 1

Step 2

Step 3

Step 4

Step 5

visit - https://www.surepassexam.com



\i/ Exam Recommend!! Get the Full 210-060 dumps in VCE and PDF From SurePassExam
Ll Sure PaSS https://www.surepassexam.com/210-060-exam-dumps.html (305 New Questions)

The phone uses DHCP to learn its IP acidress, subnet : The phone obtains the Power (PoE or AC adapter) :
mask, default gateway and TFTP server address | .
|
|

The phone loads its locally stored firmwareimage | | The phone loads its locally stored firmware image

r1 |
; |
| |
b |

Vo Sz L Lot by Mo lo_ La b 4 |

| The phone learns the Voice VLAN ID via COP from

The phone contacts the TFTP server and requests its

| | i
| config file. Each phone has a customized config file named |L the switch :
’ SEP. cnf. xmi created by CUCM and uploaded to TFTP : | |
I when the administrator creates or modifies the phone || | '
L

The phone obtains the Power (PoE or AC adapter) The phone uses DHCP to learn its IP address, subne

o ol

|
|
mask, default gateway and TFTP server address |
|
|

irThe phone learns the Voice VLAN ID via COP from The phone contacts the TFTP server and requests its :
the switch config file. Each phone has a customized config file named |
; SEP. cnf. xmi created by CUCM and uploaded to TFTP :
'; when the administrator creates or modifies the phone |

s T - i~ B - T R SR R I S = R L
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NEW QUESTION 289

An engineer receives an isolated report that the customer can make calls successfully from an IP phone to other IP phones, but receives an error recording when
attempting to call someone over the PSTN. The user cannot recall the error recording to provide the specific error message. Which two steps should the network
engineer take to begin troubleshooting? (Choose two.)

A. Enable debug isdn q931 on the gateway and have user make the same call from the IP phone to PSTN again.
B. Check the region used by the IP phone in Cisco Unified Communications Manager.

C. Test the call using Dialed Number Analyzer in Cisco Unified Communications Manager administrator.

D. Check the calling search space used by the line on the IP phone in Cisco Unified Communications Manager.
E. Check the gateway to determine which codec is being used by the appropriate dial peer.

Answer: CD

NEW QUESTION 291
After getting reports that users cannot make calls out to the PSTN, a network administrator opens the Cisco Unified Communications Manager Administration web
page and begins to review route patterns. Why would the administrator look here when troubleshooting PSTN connectivity troubles?

A. A route pattern contains a list of gateways that can reach the PSTN.
B. A route pattern contains dial plan information for calling the PSTN.

C. A route pattern contains the necessary privileges for calling the PSTN.
D. A route pattern contains a list of SIP trunks that can reach the PSTN.

Answer: B

NEW QUESTION 295

A company has invested in an on-premises VolP solution. For design simplicity purposes, network engineers have opted to use a single VLAN for both data and
voice traffic. Shortly after implementing IP phones, customers are reporting problems.

Which two potential problems may be reported about the calls as a result of this design decision? (Choose two.)

A. jitter detected in voice calls

B. problems with email latency

C. slow internet download speeds

D. choppy voice calls

E. PCs are getting IP addresses but phones are not
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Answer: AD

NEW QUESTION 298
A field technician must reset a single 7965 IP phone so that it will be discovered on the network again and request an IP address from DCHP. Which steps should
the network engineer provide?

A. Have field technician select the Settings button on phone, then dial # # * * *
B. Have field technician select the Settings button on phone, then dial # # * # #
C. Have field technician select the Settings button on phone, then dial * * # * *
D. Have field technician select the Settings button on phone, then dial * * # # #

Answer: C

NEW QUESTION 301
An entire department is reporting frequent calls with poor voice quality. Which fault domain should be investigated first?

A. IP phone

B. Cisco Unified Communications Manager Media Resources
C. Cisco Unified Communications Manager SIP Trunks

D. network routers and switches

Answer: D
NEW QUESTION 304
How many servers can be supported in a Cisco IM and Presence Service Cluster?

0

moow2>
Ao N

Answer: D

NEW QUESTION 307
An engineer must import many users at the same time into Cisco Unity Connection. Which method must be used?

A. manual creation

B. CAPF profiles

C. COBRAS

D. bulk administration

Answer: D

NEW QUESTION 308
Which two user types are available to a voice engineer adding a user in Cisco Unity Connection? (Choose two.)

A. User with mailbox

B. Imported user

C. Synch user

D. User without mailbox

E. Local admin user with mailbox

Answer: AD

NEW QUESTION 312
A technician is checking services in response to the recent failed delivery of all voicemails. Which service must be running for message delivery to function
properly?

A. Connection DBEvent Publisher

B. Connection Database Proxy

C. Connection Notifier

D. Connection Message Transfer Agent

Answer: D

NEW QUESTION 314
Which three locations can an administrator import from to create users on Cisco Unity Connection? (Choose three.)

A. Bulk administration tool

B. LDAP

C. Cisco Unified Communications Manager via AXL
D. Outlook

E. Presence

F. Cisco Compatible Extensions
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Answer: ABC

NEW QUESTION 319
Which client supports Cisco Unified Presence?

A. Jabber
B. Lync
C. Skype

D. Quip

Answer: A

NEW QUESTION 320
Which transport layer protocol is used when a Cisco Unified Presence client is searching for a contact in directory?

A.TCP
B. UDP
C. IMAP
D. HTTP

Answer: A

NEW QUESTION 324
In which location is Cisco Unified Presence enabled for a specific user in Cisco Unified Communications Manager?

A. User Administration

B. Application

C. Advanced Features

D. Capabilities Assignment
E. on the IP phone

Answer: D

Explanation: Capabilities Assignment allows system administrators to enable the Cisco Unified Presence (CUP) and Cisco Unified Personal Communicator
(CUPC) capabilities for users. You must ensure that licenses for CUP and CUPC are available.

Link: http://www.cisco.com/en/US/docs/voice_ip_comm/c

ucm/admin/8_6_1/ccmfeat/fslicense.html#wpl1158223

NEW QUESTION 329
Which option would an administrator use to find all unassigned directory numbers in Cisco Unified Communications Manager?

A. Route plan report

B. CDR

C.CAR

D. Cisco Reporting Tool

E. Directory number lookup

Answer: A

NEW QUESTION 333
Which option allows an engineer to deploy new firmware to a single phone, while reducing possible impact?

A. Define a new firmware load on specific devic
B. Save configuration and reset individual device.
C. Define load in device default

D. Reset Device Pool.

E. Upload firmware to TFTP serve

F. Restart TFTP service.

G. Enable Peer Firmware Sharing.

Answer: A

NEW QUESTION 335

Which command to assign manualy IP to EX series using CLI?
A. Xcommand set network IPV4 address:

B. xconfiguration network address EthernetO:

C. Xconfiguration network IPV4 address NICO:

D. Xconfiguration network IPV4 address:

Answer: D

NEW QUESTION 339
A user report hearing an Echo on Call what are two common causes of echo on a Voip Networking (choose two)
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A. Network packet loss
B. Ata

C. Headset use

D. Speakrphone Use
E. RFI

Answer: AD

NEW QUESTION 341
User A needs to have a line shared on the user B phone. Both phones register with Cisco Unified Communications Manager. Which method can be used from
Cisco Unified Communications Manager Administration web pages to configure a shared line on the user B phone?

A. Navigate to the user B phone > Add the user ADN.

B. Navigate to the user B phone > Shared Line > Add the user ADN.

C. Navigate to DN configuration > Shared Line > Add the user ADN.

D. Navigate to end user configuration > Shared Line > Add the user ADN.

Answer: A

NEW QUESTION 346
Which three options are the correct methods to implement end users in Cisco Unified Communications Manager? (Choose three.)

A. manually

B. DHCP

C. bulk import using BAT
D. TFTP

E. LDAP synchronization
F. autoregistration

Answer: ACE

NEW QUESTION 347
A single user receives a high amount of inbound voice messages and checks them only via email. The user cannot receive or send messages as the mailbox is
full. Which option provides a permanent solution to this problem?

. message aging policies
. mailbox size quota

. multiple mailbox stores
. call-routing rules

. restriction tables

mooOw>

Answer: A

NEW QUESTION 352
An engineer is creating a new phone using the Call Manager. Which option is presented first when you click the Add New button?

A. Phone Type

B. BAT Phone Template
C. MAC Address

D. Common Phone Profile

Answer: A

NEW QUESTION 357
Which three rules are valid transfer rules in Cisco Unity Connection? (Choose Three)

A. Standard

B. alternate

C. closed

D. holiday

E. nonstandard

Answer: ABC

Explanation:

Standard Transfer Rule

This transfer rule applies during the work hours that your Cisco Unity administrator specified for your organization, or in other situations when no other transfer rule
is enabled.

By design, the standard transfer rule cannot be disabled. Alternate Transfer Rule

Enable this transfer rule to apply during a specific time period when you want to override the other transfer rules. For example, you may want to route all your calls
directly to voice mail while you are out of the office or you may want to transfer your calls to a different extension if you are temporarily working from another
location.

As long as it is enabled, the alternate transfer rule overrides all other transfer rules. Closed Transfer Rule

Enable this transfer rule if you want Cisco Unity to perform different transfer actions during the nonwork hours that your Cisco Unity administrator specified for your
organization. (For example, you may want to route all your calls directly to voice mail during nonwork hours.)

As long as it is enabled, the closed transfer rule overrides the standard transfer rule during nonbusiness hours.
http://www.cisco.com/en/US/docs/voice_ip_comm/unity/5x/user/guide/assistant/ex/cuugasste070.html
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NEW QUESTION 361
Which profile must be added to the end user profile when enabling an end user for Cisco Unified Presence?

A. Device profile

B. UC service profile

C. Extension mobility profile
D. SIP profile

Answer: B

NEW QUESTION 362
End user is on a cisco telepresence session with remote participant and can control the camera at the remote endpoint. Which feature is underlying?

A. FECC
B. DTMF
C.FEC
D. PIP

Answer: A

NEW QUESTION 366
What is the recommended maximum one-way latency for voice and video networks?

A. 100 ms
B. 150 ms
C. 200 ms
D. 300 ms

Answer: B

NEW QUESTION 368
Which port is configured for connection to the PSTN?

Answer: D

NEW QUESTION 371
An administrator is setting up a remote site in Cisco Unified Communications Manager that has a T1 WAN connection to the main site. Which option is the best
VolIP codec for this task?

A.G.711
B. G.729
C.G.712
D. G.723

Answer: B

NEW QUESTION 374
An administrator wants to gauge the load and performance capacity of Cisco Unified Communication Manager devices, including conference bridges, gateways,
and trunks. Which report would the administrator run?

A. CAR
B. CDR
C.SIP
D. RTMT
E. CUBE

Answer: A

NEW QUESTION 377
An engineer is configuring the Cisco Unified Communications Manager disaster recovery system. Which two statements about the disaster recovery system are
true? (Choose two.)

A. It requires the use of schedules for backups.

B. Backup files are encrypted using the cluster security password.

C. If the backup device is listed in a backup schedule, it cannot be manually deleted.
D. If the backup does not complete within 40 hours, the backup times out.

E. Archiving backups to tape drives is supported.

Answer: BC
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NEW QUESTION 381
An end user has made more attempts to log in than allowed, using the wrong voice-mail pin. The user has been locked out. Which submenu does an administrator
select to unlock the pin?

A. Change password
B. Password settings
C. Message settings
D. Mailbox

Answer: B

NEW QUESTION 383
Two departments have their own call-park slot to park calls. Which feature on Cisco Unified CME allows one department to answer a call for another department?

A. Call park

B. Call forward
C. Call transfer
D. Pickup-group
E. Barge-in

Answer: D

NEW QUESTION 388
The Voice engineer in your company need to change IP address destination on SIP-Trunk on near side?

A. reset trunk on near side

B. reset trunk on far side

C. reset trunk on far and near side
D. restart call manager service

Answer: A

NEW QUESTION 390
Which type of template should be used when a network engineer adds a new call center agent in the Cisco Unity Connection?

A. Contact

B. Call handler
C. User

D. Notification

Answer: C

NEW QUESTION 392
In which section of Cisco Unified Communications Manager are Call Detail Records viewed?

A. Cisco Unified Serviceability

B. Cisco Unified OS Administration

C. Cisco Unified Reporting

D. Cisco Unified Communications Manager Administration
E. Cisco Unified Disaster Recovery

Answer: A

NEW QUESTION 393

Which utility is recommended for a network administrator who must provision 300 users in Cisco Unified Communications Manager?
A. Batch Accounts Tool

B. Bulk Administration Tool

C. Bulk Accounts Tool

D. Batch Administration Tool

Answer: B

NEW QUESTION 397

A networking administrator needs to add a new user in Cisco Unified Communications Manager. Where must the administrator navigate to accomplish this task?
A. Device Association

B. User Management

C. Application

D. Application User

Answer: B

NEW QUESTION 398
Use the router console to view the configuration and answer the question.
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Exhibit1

HQ BR
PC1 HQ Video Phone 1 HQ Video Phone 2

- 10.%.5.1
15 AT 4 19
.
P &
cuc

.18
CUcmM IMP L LDAFP MediaSense

10.%.130.1 BR Phone

WAN Subnet
| oHCP DHerl 10.X.110.1 10.X.13.0/30
10.X 10.1
PSTN PSTN

CUCME DHCP

PSTN Phone

BR-Router

'
'

BR-Router$ l

When a call is placed from the Branch Router phone to the PSTN number of 914085551212, the call is failing. What dial-peer is supposed to be used and why is
the call failing? Select 2 (two)

A. dial-peer voice 910 pots

B. dial-peer voice 9 pots

C. dial-peer voice 9001 voip

D. destination pattern is incorrect

E. prefix is missing from the dial-peer

F. the port assignment is incorrect in the dial-peer
G. the port number is missing in the dial-peer

Answer: BF

Explanation: The dial 9, 910, and 9001 dial peer configurations are shown below:
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|

dial-peer voice 9 pots
description Local PSTN Calls
destination-pattern 9[1-9]T
port ©0/6/0:12

|

dial-peer voice 900 pots
description International
destination-pattern 900T
port ©/6/0:15
prefix 900

|

dial-peer voice 910 pots
description National
destination-pattern 9[1-9]T
port ©/6/0:15
prefix ©

!

Here we see that dial peer 9 and 910 match the same destination pattern, but 9 will be used first. However, the port used should be 0/0/0:15 not 0/0/0:12.
interface Seriale/e/0:15

no ip address

encapsulation hdlc

isdn switch-type primary-net5
isdn incoming-voice voice

no cdp enable
!

NEW QUESTION 401
A user is required to answer voicemail for two lines but would like them to be filtered to only one mailbox. How can you accomplish this request?

A. Provide multiple mailboxes for one Cisco Unity Connection user.
B. Add an alternate extension.

C. Create a shared mailbox.

D. Initiate interview handler.

Answer: B

NEW QUESTION 402
Use the exhibits below to answer the question.
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Exhibit1

10/23/2014 14:40 | 2001

Phone Information
Model Number: CP-9971 (Video)

IPv4 Address: 10.1.111.5
Host Name: SEPB8478ACE71D1F

Active Load:

sip9971.9-4-1-9

Last Upgrade: 12/31/81 19:02

Active Server: 18:1.5:16

Stand-by Server: 10.1.5.15

Exhibit2

Product Type: Cisco 9971
Device Protocol: SIP

— Real-time Device Status
Registration: Unknown

IPv4 Address: Nong

— Device Information
ﬁ Device is Active

E Device iz trusted

MAC Address™ 8478BACFI1D1F

Description HQ-Phone 1

Device Pool * Default V| View Details
Common Device Configuration < Mone = v] View Details
phone Button Template™ | Standard 9971 SIP v

Softkey Template < None = v]

Common Phone Profile * | Standard Commen Phone Profile V| View Details
Calling Search Space phonel _css A4

AAR Calling Search Space < None = AV

Media Resource Group List < None = W

User Hold MOH Audio Source < None = AV

Netwerk Hold MOH Audio Source | < None = W

Location™ Hub_None i

AAR Group | < None > v
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Exhibit3

File Help

Cisco Jabber

e Cannot communicate with the

SEIVEI.

Please enter your username and password for
Jabbervoice services

jdoe@cisco.collab.com

Forqot password?

B Sign me in when Cisco Jabber starts

What two issues could be causing the Cisco Jabber failure shown in the exhibit? (Choose two)

A. Incorrect username and password

B. IM & Presence server is down

C. User is not associated with the device

D. IP or DNS name resolution issue

E. CSF Device is not registered.

F. IP Phone DN not associated with the user

Answer: BD

Explanation: The error message shown in Jabber is “Cannot communicate with the server” which points us to a connectivity issue with IP/DNS or the server is
down. All other answer choices would result in a login failure, not communication error.

NEW QUESTION 407
How to enable existing remote jabber to register to cucm without VPN?

A. expressway with jabber guest
B. Vcs with jabber guest

C. expressway with MRA

D. Vcs with MRA

Answer: C

NEW QUESTION 410

Which protocol allows Cisco Unified Communications Manager to take control of a specific port on a gateway?
A. SIP

B. H.323

C.Q.931

D. MGCP

Answer: D

NEW QUESTION 413
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Which navigation pane should be selected to view the CDR statistics?

A. Cisco Unified Serviceability

B. Cisco Unified CM Administration
C. Cisco Unified Reporting

D. Cisco Unified OS Administration

Answer: A

NEW QUESTION 415
Which two options are configured on the phone configuration page within Cisco Unified Communications Manager Administrator? (Choose two.)

A. device pool

B. auto answer

C. partition

D. voice-mail profile
E. MAC address

Answer: AE

NEW QUESTION 419
Which of the following are causes of ECHO? (Choose two.)

A. Headset

B. Speakerphone

C. Radio interference
D. Loud volume

Answer: AB

NEW QUESTION 422
Many users report that there is a delay in receiving MWI notifications for voicemails. Which two issues can cause this problem? (Choose two.)

A. The Connection Notifier service has been stopped.

B. Voicemail ports are not configured for MWI requests.

C. The MWI functionality for the port groups has been disabled.

D. Not enough MWI assigned ports are available.

E. MWIs are in the process of synchronizing with the phone system.

Answer: DE

NEW QUESTION 423
Which two password options are recommended when setting up a voicemail box that multiple users will access? (Choose two.)

A. User Cannot Change

B. No Password

C. Does Not Expire

D. User Must Change at Next Login
E. Locked By Administrator

Answer: AC

NEW QUESTION 425
A user reports that when they receive a voicemail on their phone, they do not receive it in their email as well. Which feature on Cisco Unity Connection should be
checked?

A. Cisco Unified Messaging Service
B. Enterprise Parameters

C. Roles

D. Message Waiting Indicators

E. Alternate MWI

Answer: A

NEW QUESTION 429

Which of the following is not a source for Cisco Unified Reporting?
A. Cisco Unified CM database

B. Cisco Unified Presence database

C. Cisco Unified CM RTMT counters

D. Cisco Unified CM CDR/CAR

Answer: B

NEW QUESTION 433
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Which Cisco Unified CME GUI menu option is used to navigate to the screen used to add or change a user name or password using the Cisco Unified CME GUI
interface?

A. Administration > Update System Info
B. Configure > System Parameters

C. Configure > Phones

D. Configure > Extensions

Answer: C

NEW QUESTION 437
Which four actions can be selected with the Bulk Administration Tool in Cisco Unity Connection? (Choose four.)

. Create

Modify

. Migrate

. Update
Delete
Export

. Purge

. Manage

IOITMUO®>

Answer: ADEF

NEW QUESTION 438
Which protocol is used between two Cisco IP phones once Cisco Unified Communications Manager Express connects a call?

A. H.323
B. RTP
C. SCCP
D. SIP

Answer: B

NEW QUESTION 439
An engineer is adding four cordless analog phones to Cisco Unified Communications Manager. Which solution best meets this requirement?

A. Cisco VG202 Analog Voice Gateway
B. Cisco VG204 Analog Voice Gateway
C. Cisco VG224 Analog Voice Gateway
D. Cisco VG350 Analog Voice Gateway

Answer: B

NEW QUESTION 440
IP phone users report that the MWI light does not work while receiving VM messages. Which action must be taken to troubleshoot this issue?

A. Check the user mailbox size

B. Run the Port Activity report

C. Reset MWI function in the Cisco Unity Connection
D. Reset the IP phone

Answer: B

NEW QUESTION 445
Which three pieces of information are provided to the Cisco phone by the DHCP server after a reset has been initiated? (Choose three.)

A. default gateway
B. dial tone

C. ARP table

D. SIP proxy server
E. IP address

F. TFTP servers

Answer: AEF

NEW QUESTION 450
Which three network elements are crucial when deploying VolP devices? (Choose three.)

A. Round-trip time
B. QoS markings
C. Bandwidth

D. Ethernet

E. Fibre

F. Token ring

Answer: ABC
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NEW QUESTION 453
Which service allows the network to provide better or special services to a set of users and applications at the expense of other users and applications?

A. QoS

B. dial plans

C. route patterns
D. dial peers

Answer: A

NEW QUESTION 455
How does a MGCP CALL AGENT route calls?

A. Route-pattern

B. Directory number
C. Route list

D. Wildcard pattern

Answer: A

NEW QUESTION 459
An administrator has determined that an end user is experiencing jitter. Which symptom is the end user experiencing?

A. choppy

B. crosstalk
C. static

D. screeching

Answer: A

NEW QUESTION 464
Which two choices best describe call signaling and media flows? (Choose two.)

A. a process used to connect two parties calling

B. audio or video or both transferred between two parties during conversation
C. protocol for end-to-end users

D. a flow of audio and instant messaging

E. all call control signals being delivered through a channel

F. data telephony, over a data network such as the Internet

Answer: AB

NEW QUESTION 468
Which two standard supported for streaming live video on cisco telepresence content server (choose two)?

A. H265
B. H263
C. H270
D. H261
E. H262

Answer: BD

NEW QUESTION 473
How can an end user be defined as a manager in the CAR tool?

A. Configure a Manager ID field in end user configuration
B. Add the end user to the Standard CCM Manager group
C. Check the Manager check box in the LDAP directory
D. Enable an end user as a manager in the CAR tool

Answer: A

NEW QUESTION 478

An engineer wants to ensure that Cisco Jabber clients can communicate with instant messaging clients who are not registered to the same Jabber cluster. Which
technology meets this requirement?

A. intercluster trunk

B. federation

C. SIP trunk

D. PRI

Answer: B
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NEW QUESTION 479

Which Cisco Unified Communications Manager plug in allows administrators to proactively monitor the overall health of their Cisco cluster?

A. RTMT

B. Cisco AXL Toolkit
C. Cisco CTL Client
D. Cisco JTAPI

E. Cisco TAPS

Answer: A

NEW QUESTION 483

Use the router console to view the configuration and answer the question.

Exhibit 1

HQ

PC1 HQ Video Phone 1 HQ Video Phone 2

& &

| oHcp pHepl  10.x110.1
10X 10.1

CuUcm

589

10.X.5.1
4 19

LDAP MediaSense

WAN Subnet
10.X.13.0/30

BR

PSTN

PSTN Phone

10.X.130.1 BR Phone

DHCP

BR-Router

BER-Routers

'
I
I

International calls are also failing. Using the router configuration supplied, why are international calls failing?

A. Prefix should be 00

B. The character "T" cannot be used in a Pots dial pattern
C. The port should be 0/0/0:12
D. The destination pattern is missing a "0"

Answer: A
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Explanation: The International dial peer configuration is shown below:
dial-peer voice 900 pots
description International
destination-pattern 9060T

port ©/@/0:15

prefix 900
!

The prefix is incorrectly set to 900, not 00.

NEW QUESTION 485
An engineer is adding user accounts to Cisco Unity Connection and needs to limit the maximum length of messages. Which attribute defines this limit when adding
new accounts?

A. user mailbox store
B. user roles

C. user templates

D. user CoS

Answer: D

NEW QUESTION 487
An IT administrator must allow a customer service department supervisor to change or modify a recorded message on their phone system. Which role is needed to
accomplish this?

A. Greeting Administrator
B. Recordings Administrator
C. Remote Administrator
D. Annunciator Administrator

Answer: D

NEW QUESTION 489
An engineer is configuring a user to have Cisco Extension Mobility. Where is the line configured?

A. Device Profile
B. CAPF Profile
C. Primary Extension
D. User Configuration

Answer: A

NEW QUESTION 494
Which component allows Cisco Jabber to communicate with clients who are outside the corporate network?

A. Cisco Extension Mobility

B. Cisco TMS

C. Cisco Mobility Remote Destination
D. Cisco Unified RTMT

E. Cisco Mobile and Remote Access

Answer: A

NEW QUESTION 495
An engineer must run a CUCM report on the number of local calls with poor voice quality. Which report type provides this information*?

A. QoS by Gateway report
B. QoS Detail report

C. QoS hy Call Types report
D. QoS Summary report

Answer: C

NEW QUESTION 500
An IT administrator is having issues with registering an 7900 series IP phone The admin cannot review phone settings because they are locked Which sequence
allows the administrator to unlock the settings?

**#
*#

*#*
#**

OO w>»

Answer: D
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NEW QUESTION 503
An administrator must keep CDR data for a longer period of time and wants to modify the configured value of the CDR/CMR Files Presentation Duration Days).
Which menu options does the engineer navigate?

A. Unified CM Administration > System > Enterprise Parameters

B. Unified Serviceability > Tools > Serviceability Reports Archive

C. Unified CM Administration > Call Routing > Route Plan Report
D. Unified Serviceability > Tools > CDR Management

Answer: A

NEW QUESTION 506
What is the maximum amount of packet loss an engineer should allow for voice traffic on an IP network?

A. 5 percent
B. 2 percent
C. 3 percent
D. 1 percent

Answer: A

NEW QUESTION 511
A voice engineer is enabling Cisco AutoQoS . Which command is required on a Cisco switch to configure this feature?

A. auto qos enable
B. enable voip auto
C. auto qos voip

D. qos enable

Answer: C

NEW QUESTION 516

A network administrator finds directory number 77555 in the <none> partition. Which numbers can reach 77555 in this situation?
A. Only numbers in the <none> partition can reach 77555.

B. All numbers in every calling search space can reach 77555.

C. Only internal directory numbers can reach 77555.

D. Directory number 77555 cannot be reached by any number.

Answer: A

NEW QUESTION 521

Answer:

Explanation: Call Detail Record:

Called and Calling numbers

Time/date stamp for connect and disconnect
Call Management Record:
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Jitter Latency
https://supportforums.cisco.com/t5/collaboration-voice-and-video/understanding-cdr-call-detail-records/ta-p/311

NEW QUESTION 523
IP WAN failure has occurred. Which two configurations must be made to allow calls to or from an IP phone at a branch location to complete to a destination
outside of that branch? (Choose two.)

A. Survivable Remote Site Telephony is configured on the branch router.

B. LAN failover configuration is set to Survivable Remote Site Telephony.

C. Call Forward UnRegistered option is configured on each branch phone profile.
D. POTS WAN failover is set to Survivable Remote Site Telephony.

E. An ISDN is configured as a primary survivable backup site

Answer: CE

Explanation: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/srnd/collab10/collab10/models.html

NEW QUESTION 528
A network administrator wants a new employee to download the RTMT tool. Which menu option supports this function?

A. Bulk Administration > Job Scheduler > Plugins
B. Application > Plugins

C. Call routing > Plugins

D. Server > Region > Plugins

Answer: B

Explanation: https://supportforums.cisco.com/t5/collaboration-voice-and-video/using-rtmt-to-monitor-cisco-unity-connection

NEW QUESTION 529
Which two configuration options are used to populate users in Cisco Unified Communications Manager? (Choose two)

. system > LDAP > LDAP System

. system > LDAP > LDAP system > LDAP synchronization
. user management > credential policy default

. system > LDAP > LDAP directory

. system” enterprise parameters

mooO P

Answer: AD

Explanation: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/11_5/CJAB_BK DO00D8CBD_00_deployment-in

NEW QUESTION 533
Which two explanations of DTMF dialing are true? (Choose two.)

A. DTMF dialing consists of simultaneous voice-band tones generated when a button is pressed on a telephone.
B. The use of DTMF enables support for advanced telephony services.

C. DTMF dialing uses INVITE messages to signal when the first digit is pressed in a new call.

D. DTMF dialing consists of a simultaneous digital-band pulse generated when a button is pressed on a telephone.

Answer: AB

Explanation: https://www.cisco.com/c/en/us/td/docs/ios-xml/ios/voice/sip/configuration/12-4t/sip-12-4t-book/voi-sip-dtmf.ht

NEW QUESTION 538
A voicemail user reports that he cannot access Cisco Unity Connection from the IP phone message button. Which option must you perform to resolve the
problem?

A. In Cisco Unified Communications Manager, navigate to Advanced Features > VVoicemail to confirm that the user has the correct voicemail profile
B. In Cisco Unified Communications Manager, navigate to Device > Phone to confirm that the device has the correct voicemail profile

C. In Cisco Unified Communications Manager, navigate to Device > Phone to confirm that the directory number has the correct voicemail profile

D. In Cisco Unified Communications Manager, navigate to User Management > End User to confirm that the user has the correct voicemail profile
E. In Cisco Unity Connection, navigate to Users > Users to confirm that the user web password is correct.

Answer: C
NEW QUESTION 541
What are three ways for an administrator to create users in Cisco Unity Connection? (Choose three.)

A. use the Bulk Administration Tool
B. import from Cisco Unified Communications Manager Express
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C. import from a Microsoft Word document

D. import from an Adobe PDF document

E. use manual creation

F. import from a Microsoft Outlook contacts list
G. import from LDAP

Answer: ABG

NEW QUESTION 543
Which two user attributes must be defined in Cisco Unity Connection before the users can be added? (Choose two.)

A. Display name
B. Alias

C. Time zone

D. Class of service
E. Dial plan

Answer: DE

Explanation: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/administration/guide/b_cucsag/b_cucsag

NEW QUESTION 545
An engineer must ensure that user data is maintained in lightweight directory access protocol and copied to Cisco Unity Connection, but Cisco Unity Connection-
specific data is locally maintained in the Cisco Unity Connection database. Which user creation option accomplishes this task?

A. bulk administration

B. import from CUCM via AXL
C. import from LDAP

D. manual creation

Answer: A

Explanation: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/administration/guide/b_cucsag/b_cucsag

NEW QUESTION 550
An engineer is configuring an analog terminal adapter with the device name ATA1CE6C773BA96 Which MAC address should the engineer use to configure the
second port?

A. 1CE6C773BA96

B. ATA1CE6C773BA96
C. aaaaaaaaaaaa

D. ffffffffff

E. E6GC773BA9601

Answer: E

NEW QUESTION 554
How are calls routed in an MGCP call agent?

A. by route patterns on Cisco Unified Communications Manager

B. by dial peers on the gateway

C. by static routes on the gateway

D. by a translation pattern on Cisco Unified Communications Manager

Answer: A

NEW QUESTION 558
Cisco Unified Communications Manager clustering creates scalability in a network Which administrative action increases performance in a Cisco Unified
Communications Manager cluster?

A. enabling DSP process in the Cisco Unified Communications Manager GUI
B. using only one endpoint to create redundancy

C. providing multiple points for remote administration

D. segregating processes to other machines

Answer: D

NEW QUESTION 560

An engineer has updated the company dial plan and wants to get rid of unassigned numbers. Which action must be taken in Cisco Unified Communications
Manager to accomplish this task?

A. Delete unassigned DNs under Route Group.

B. Delete unassigned DNs under Route Plan Report.
C. Delete unassigned DNs under Route List.
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D. Delete unassigned DNs under Route Pattern

Answer: B

NEW QUESTION 564
An engineer is configuring a new directory number in the Call Manager Which field is responsible for incoming calls

A. Route Partition

B. Private Line Automatic Ringdown
C. Calling Search Space

D. External Call Control Profile

Answer: B

NEW QUESTION 568
Which address is required to create a video endpoint in Cisco Unified Communications Manager?

A. MAC
B.IP
C.E.164
D. SIP URI

Answer: D

NEW QUESTION 573
Two users have IP phones running SCCP phone loads. Which purpose does the SCCP protocol serve during the call?

A. digitizing, sampling, and transmitting one user's analog voice to the Cisco Unified Communications Manager

B. subscriber digitizing, sampling, and transmitting one user's analog voice to the other user's IP phone

C. passing call setup and teardown messages between the IP phone and the Cisco Unified Communications Manager
D. subscriber passing call setup and teardown messages between the two phones

Answer: C

NEW QUESTION 576
A user directory number is configured to forward all calls to a cell phone, but calls are not successfully forwarding. Which Cisco Unified Communications Manager
setting requires reconfiguration?

A. DN External Mask

B. DN Route Partition

C. DN Calling Search Space
D. CFA Calling Search Space

Answer: D

NEW QUESTION 577
A manager is generating bill reports for a particular user. Which navigation sequence must be used for this task?

A. Bills > Department

B. User Reports > Bills > Department
C. Bill > Individual

D. User Reports > Bills > Individual

Answer: D

Explanation: https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/service/8_5_1/car/CAR/caruserb.pdf

NEW QUESTION 582
Which three devices can be used to interface with the public switched telephone network? (Choose three.)

A. Cisco Unified SRST

B. Cisco Unified Border Element

C. Foreign Exchange Office Voice Interface

D. Cisco VG224 Analog Voice Gateway

E. Cisco E1/T1 ISDN PRI Network Module

F. Foreign Exchange Station Voice Interface Card

Answer: ACF
NEW QUESTION 585
A voice admin is trying to help a user to remotely change the call forward busy settings for a directory number. Which option shows how to make this change

remotely?

A. Log in to https://<ipaddressofpublisher>/ucmuser > general settings.
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B. Log in to https://<ipaddressofpublisher>/ucmuser > phone > phone settings.
C. Log in to https://<ipaddressofpublisher>/ucmuser > phone > call forwarding > advanced calling rules.
D. Log in to https://<ipaddressofpublisher>/ucmuser > voicemail.

Answer: C

NEW QUESTION 587
What allows a phone user to log a phone out of all line groups to which the phone directory numbers belong?

A. Cisco IPPA

B. Cisco Finesse

C. HLog softkey

D. Cisco Agent Desktop

Answer: C

Explanation: https://supportforums.cisco.com/t5/other-collaboration-voice-and/allowing-cfa-for-a-phone-in-a-hunt-group/td-p

NEW QUESTION 591
A user presses the envelope button on a 7945 IP phone, but it only launches audio voicemail. Where should the voice systems administrator troubleshoot?

A. Visual voicemail IP phone service in Cisco Unity Connection

B. Visual voicemail IP phone service in Cisco Unified Communications Manager

C. SIP trunk between Cisco Unified Communications Manager and Unity Connection
D. IP phone network connectivity

Answer: C

NEW QUESTION 594
Which default user account is created by Cisco Unity Connection without a voice mailbox?

A. administrator

B. undeliverable messages
C. operator

D. technician

Answer: B

NEW QUESTION 595

The Cisco Unified IP Phone 9971 supports which protocol accessing the CLI to gather information and use debug commands?
A. SSHv2

B. SSHv1

C. CDP

D. Telnet

Answer: D

NEW QUESTION 600
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